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FORWARD 

 

          It is my great pleasure to present this laboratory manual for second year engineering 

students for the subject of Electronic Workshop keeping in view the vast coverage required for 

visualization of concepts of basic electronic circuits. 

 

         As a student, many of you may be wondering with some of the questions in your mind 

regarding the subject and exactly that has been tried to answer through this manual.  

 

        Faculty members are also advised that covering these aspects in initial stage itself will 

greatly relieve them in future, as much of the load will be taken care by the enthusiastic energies 

of the students, once they are conceptually clear. Students are advised to thoroughly go through 

this manual rather than only topics mentioned in the syllabus as practical aspects are the key to 

understanding and conceptual visualization of theoretical aspects covered in the books. 

 

 

    Good Luck for your Enjoyable Laboratory Sessions. 

 

 

 

 

 

 

 

 

 

 

 

 

 Prof. V.V.Ukarande 

                                                                                                                      
             

                                                                                                                      Author 
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 1. DOs  and DON’Ts in Laboratory: 

 

 

1. Do not handle any equipment before reading the instructions/Instruction manuals. 

 

2. Apply proper voltage to the circuit as given in the procedure. 

  

3. Maintain safe distance while using soldering gun and drilling machine. 

 

4.  Strictly observe the instructions given by the teacher/Lab Instructor. 

 

 

2 Instruction for Laboratory Teachers: 

 

1. Lab work completed during prior session should be corrected during the next lab session.  

 

2. Students should be guided and helped whenever they face difficulties. 

 

3. The promptness of submission should be encouraged by way of marking and evaluation 

patterns that will benefit the sincere students.   
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                                Experiment No. 1:Pre-Requisite 1 

Aim: Study of CRO, Function Generator and Power Supply 

Equipements: CRO,Power Supply & Function Generator 

Theory: 

A. CATHODE RAY OSCILLOSCOPE (CRO) 

The Oscilloscope is probably the single most versatile and useful Test and Measurement 

instrument invented for Electronic measurement applications. It is a complex instrument capable 

of measuring or displaying a variety of signals. This is the basic equipment used in almost all 

electronic circuit design and testing applications. CRO, Oscilloscope and Scope are the common 

names by which it is known. The major subsystems in a CRO are Power supplies (high and low 

voltage supplies), Display subsystem, Vertical deflection subsystem, and Horizontal 

deflection subsystem. 
 

The main use of a CRO is to obtain the visual display of an electrical voltage signal. If the signal 

to be displayed is not in the voltage form, it is first converted to this form. The signal voltage is 

then transmitted to the oscilloscope along a cable (usually a coaxial cable) and enters the 

oscilloscope where the cable is connected to the scope input terminals. Often the signal at this 

point is too small in amplitude to activate the scope display system (the Cathode Ray Tube or 

CRT). Therefore, it needs to be amplified. The function of the vertical deflection system is to 

perform such amplification. After suitable amplification, the input signal is applied to the vertical 

deflection plates of the scope CRT. Within the CRT, an electron beam is created by an electron 

gun. The electron beam is focused and directed to strike the fluorescent screen, creating a spot of 

light, where impact is made with the screen. The beam is deflected vertically in proportion to the 

amplitude of the voltage applied to the CRT vertical deflection plates. The amplified input signal 

is also monitored by the horizontal deflection system. This subsystem has the task of sweeping 

the electron beam horizontally across the screen at a uniform rate. A sawtooth type signal (a 

triangular/ramp signal with long time duration for the rising part of the ramp and very small time 

duration for the falling part) is internally generated in a CRO as a time-base signal (sweep 

signal). This signal is amplified and applied to the horizontal deflection plates of the CRO. 

Again, the beam is deflected horizontally in proportion to the amplitude of the voltage applied to 

the CRT horizontal deflection plates. The simultaneous deflection of the electron beam in the 

vertical direction (by the vertical deflection system and the vertical deflection plates) and in the 

horizontal direction (by the time-base circuitry and the horizontal deflection plates) causes the 

spot of light produced by the electron beam to trace a path across the CRT screen. For example, 

if the input signal to the CRO were a sine wave, the trace produced on the CRT screen will be a 

sine wave. It is important to obtain a stable display on the CRT screen. If the input signal is 

periodic and the time base circuitry properly synchronizes the horizontal sweep with the vertical 

deflection, the spot of light will trace the same path on the screen over and over again. For a 
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periodic signal the input signal can be synchronized with the time-base signal using the Trigger 

controls and the time base controls. If the frequency of the periodic signal is high enough (say 

greater than 40 Hz), the repeating trace will appear to be a steady pattern painted by solid lines of 

light on the screen 

 

                         Figure 1: Cathode Ray Oscilloscope Block Diagram 

 

B. FUNCTION GENERATOR 

                     Another major equipment, which is used commonly in electronic circuit 

applications, is a Function Generator (FG). As the name indicates, a Function Generator 

generates different voltage signals, such as Sine, Pulse, Triangle. The most commonly required 

signals in electronic circuits are Sine and Pulse. Sine wave signals find their use mostly in 

Analog circuits, such as amplifiers, filters, etc. Pulse signals are useful in testing the time 

response of circuits and also as Clock signals in Digital circuits. In a general pulse signal, the 

high and low level time periods are different. Square wave is a special case when the periods are 

equal.  

 

In a FG by the touch of a button one can switch over from one signal to another one. This is 

possible because of the fact that one can obtain different signals from a starting signal using 

Wave shaping circuits. Most FGs generate a Triangular signal and derive Sine and Pulse signals 

from it.  
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                                  Figure 2: Function Generator 

 

C.POWER SUPPLY 

          Power Supply is designed as a Constant Current (CC) and Constant Voltage (CV)source for 

use in laboratories, industries and field testing. With compact size, light weight and low power 

loss it, provides DC output voltages for Analog and Digital testing. The DC output can be 

adjustable from 0 - 30 V with Coarse and Fine controls. Current limit is adjustable from 0 - 1A. 

Over loading is indicated by LED. A 3-digit LED display for voltage & current is used to read 

the values. These two parameters can be switched to display either voltage or current. 

 

 

                                                 Figure 3: Power Supply 
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MAIN FUNCTION 

1. Output constant current adjustable. 

2. Output constant voltage adjustable. 

3. LCD voltage and current display. 

4. Constant voltage and current operation in individual. 

5. Over current protection. 

Conclusion: 
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                                     Experiment No. 2:Pre-Requisite 2 

Aim: To study Electronic Components.  

Equipments: Resisor,Capacitor,Inductor,Diode,LED,Transisor,IC 

Theory:  

Resistor:-  

A resistor is a passive two-terminal electrical component that implements electrical resistance as 

a circuit element. In electronic circuits, resistors are used to reduce current flow, adjust signal 

levels, to divide voltages, bias active elements, and terminate transmission lines, among other 

uses. High-power resistors that can dissipate many watts of electrical power as heat may be used 

as part of motor controls, in power distribution systems, or as test loads for generators. Fixed 

resistors have resistances that only change slightly with temperature, time or operating voltage. 

Variable resistors can be used to adjust circuit elements (such as a volume control or a lamp 

dimmer), or as sensing devices for heat, light, humidity, force, or chemical activity.  

Resistor Color Code Chart 

Band colour & 

its value 

Band colour & its 

tolerance 

Black = 0 

Brown = 1 

Red = 2 

Orange = 3 

Yellow = 4 

Green = 5 

Blue = 6 

Violet = 7 

Grey = 8 

White = 9 

Gold =  + - 5% 

Silver = + - 10 % 

No colour means 20 % 



12 
 

                                       

The first two bands near an end indicate first 2 digits, digit corresponding to 3rd band is the 

power of 10 to be multiplied and fourth band indicates tolerance as mentioned in the table. Refer 

fig 1, where brown = 1, black = 0, red = 2 and silver = 10 % tolerance. Hence its value is 

 10 x 10 2   Ω = 1 k Ω. 

 

Capacitor:-  

A capacitor is a passive two-terminal electrical component that stores electrical energy in an 

electric field. The effect of a capacitor is known as capacitance. While capacitance exists 

between any two electrical conductors of a circuit in sufficiently close proximity, a capacitor is 

specifically designed to provide and enhance this effect for a variety of practical applications by 

consideration of size, shape, and positioning of closely spaced conductors, and the intervening 

dielectric material. A capacitor was therefore historically first known as an electric condenser.  

                                     

                                          Figure 2: Electrolytic Capacitor 

 

Inductor:-  

An inductor, also called a coil or reactor, is a passive two-terminal electrical component that 

stores electrical energy in a magnetic field when electric current flows through it. An inductor 

typically consists of an electric conductor, such as a wire, that is wound into a coil around a core.  
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When the current flowing through an inductor changes, the time-varying magnetic field induces 

a voltage in the conductor, described by Faraday's law of induction. According to Lenz's law, the 

direction of induced electromotive force (e.m.f.) opposes the change in current that created it. As 

a result, inductors oppose any changes in current through them.  

                       

                                                   Figure 3: Inductor Symbol 

 

Diode:-  

In electronics, a diode is a two-terminal electronic component that conducts primarily in one 

direction (asymmetric conductance); it has low (ideally zero) resistance to the current in one 

direction, and high (ideally infinite) resistance in the other. A semiconductor diode, the most 

common type today, is a crystalline piece of semiconductor material with a p–n junction 

connected to two electrical terminals. A vacuum tube diode has two electrodes, a plate (anode) 

and a heated cathode. Semiconductor diodes were the first semiconductor electronic devices. The 

discovery of crystals' rectifying abilities was made by German physicist Ferdinand Braun in 

1874. The first semiconductor diodes, called cat's whisker diodes, developed around 1906, were 

made of mineral crystals such as galena. Today, most diodes are made of silicon, but other 

semiconductors such as selenium and germanium are sometimes used.  

                  
 

                                           Figure 4: P-N Junction Diode 

 

Transistor:-  

A transistor is a semiconductor device used to amplify or switch electronic signals and electrical 

power. It is composed of semiconductor material usually with at least three terminals for 

connection to an external circuit. A voltage or current applied to one pair of the transistor's 

terminals controls the current through another pair of terminals. Because the controlled (output) 
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power can be higher than the controlling (input) power, a transistor can amplify a signal. Today, 

some transistors are packaged individually, but many more are found embedded in integrated 

circuits.  

                         
                                          Figure 5: Transistor Symbol 

 

Light Emitting Diode (LED): 

Led’s are pn junction devices which emit light radiation when biased in the forward direction. 

The semiconductor material used for these junctions is a compound semiconductor like AlGaAs 

whose band gap corresponds to a particular wavelength according to equation Eg = 1.24 / λ 

where Eg is the band gap in ev and λ is the wavelength in microns. (e.g. red ~ 0.7 μ hence 

corresponding E g = 1.24 / 0.7 = 1.77 ev). When the pn junction is forward biased, the electrons 

are excited to conduction band and when they fall to the valence band, they give out energy in 

the form of radiation corresponding to the Eg of the material Conventional led’s are made from 

the materials like AlGaAs, GaAlP, GaAsP, GaP and GaN which emit Red, green, orange, yellow 

and blue colours respectively. Led’s come in a special transparent casing as shown in fig. Dual 

colour led’s are also available where two junctions are encapsulated on the same chip. It has 

three leads where cathode is common whereas normal leds’ have two leads one for cathode and 

other for anode. A very important precaution while using an led is the amount of current being 

passed through it. For most leds the maximum allowable current is 20 mA beyond which the led 

can burn out. Hence in most of the circuits a resistor is used to limit the current. Some important 

specifications before using an led are: LED colour, peak wavelength, viewing angle, optical 

power output, luminous intensity, forward current and forward voltage.   

                           
                                                      Figure 6: LED Symbol                                         
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Integrated Circuit (IC):-  

An integrated circuit or monolithic integrated circuit (also referred to as an IC, a chip, or a 

microchip) is a set of electronic circuits on one small flat piece (or "chip") of semiconductor 

material, normally silicon. The integration of large numbers of tiny transistors into a small chip 

results in circuits that are orders of magnitude smaller, cheaper, and faster than those constructed 

of discrete electronic components. The IC's mass production capability, reliability and building-

block approach to circuit design has ensured the rapid adoption of standardized ICs in place of 

designs using discrete transistors. ICs are now used in virtually all electronic equipment and have 

revolutionized the world of electronics. Computers, mobile phones, and other digital home 

appliances are now inextricable parts of the structure of modern societies, made possible by the 

small size and low cost of ICs.  

 

 
                                     Figure 7: Integrated Circuit 

Conclusion:  
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                                               Experiment No.  3 

 

Aim:To Perform Rectifier and Timer IC 555 circuits on Breadboard 

 

Components:  

Rectifier: Diode IN4007,1K ohm resistor,Breadboard kit with 12V step down transformer kit. 

Timer IC 555 circuit: IC 555,47 uF capacitor,0.01 uF capacitor,10K ohm resistor,100 K ohm 

resistor,470 ohm resistor,LED,Breadboard,Connecting wires 

Theory: 

 

Rectifier Circuit: 

A) Half  Wave Rectifier: 

When a single rectifier diode unit is placed in series with the load across an ac supply, it converts 

alternating voltage into a uni-directional pulsating voltage, using one-half cycle of the applied 

voltage, the other half cycle being suppressed because it conducts only in one direction. Unless 

there is an inductance or battery in the circuit, the current will be zero, therefore, for half the 

time. This is called half-wave rectification. 

             

                                         Figure 1: Half Wave Rectifier 

 

B) Full Wave Rectifier: 

The full wave rectifier circuit consists of two power diodes connected to a single load resistance 

(RL) with each diode taking it in turn to supply current to the load. When point A of the 

transformer is positive with respect to point C, diode D1 conducts in the forward direction as 

indicated by the arrows. 
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When point B is positive (in the negative half of the cycle) with respect to point C, 

diode D2 conducts in the forward direction and the current flowing through resistor R is in the 

same direction for both half-cycles. As the output voltage across the resistor R is the phasor sum 

of the two waveforms combined. 

 

                                            Figure 2: Full Wave Rectifier 

1. IC 555 : Monostable Mode to Flash an LED 

The LM555 timer can be used a various configurations, but the most commonly used 

configuration is in monostable mode. A typical application for the LM555 timer in monostable 

mode is to turn on an LED for specific time duration. A pushbutton is used as the trigger to 

output a high pulse when trigger pin is pulsed low. This simple application can be modified to fit 

any application requirement. 

Design Requirements: 

The main design requirement for this application requires calculating the duration of time for 

which the output stays high. The duration of time is dependent on the R and C values  and can be 

calculated by: 

 t = 1.1 × R × C seconds  

  

Detailed Design Procedure: 

 To allow the LED to flash on for a noticeable amount of time, a 5 second time delay was chosen 

for this application. By using Equation 6, RC equals 4.545. If R is selected as 100 kΩ, C = 45.4 
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µF. The values of R = 100 kΩ and C = 47 µF was selected based on standard values of resistors 

and capacitors. A momentary push button switch connected to ground is connected to the trigger 

input with a 10-K current limiting resistor pullup to the supply voltage. When the push button is 

pressed, the trigger pin goes to GND. An LED is connected to the output pin with a current 

limiting resistor in series from the output of the LM555 to GND. The reset pin is not used and 

was connected to the supply voltage. 

 

 
                             Figure 3: Circuit for Monostable Mode to Flash a LED 

In this mode of operation, the timer functions as a one-shot. The external capacitor is initially 

held discharged by a transistor inside the timer. Upon application of a negative trigger pulse of 

less than 1/3 VCC to pin 2, the flip-flop is set which both releases the short circuit across the 

capacitor and drives the output high. The voltage across the capacitor then increases 

exponentially for a period of t = 1.1 RA C, at the end of which time the voltage equals 2/3 VCC. 

The comparator then resets the flip-flop which in turn discharges the capacitor and drives the 

output to its low state. 

 

Conclusion:  
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                                                 Experiment No. 4 

 

Aim: Mini Project Electronic PCB Design-Part I-:PCB Layout Design & 

Etching 

 

Equipments: Copper clad PCB,Multimeter,Fecl3 solution 

Theory: 

 

What is PCB? 

A PCB is a printed circuit board, also known as a printed wiring board. It is used in electronics to 

build electronic devices. A PCB serves two purposes in the construction of an electronic device; 

it is a place to mount the components and it provides the means of electrical connection between 

the components. 

There are three main types of circuit boards that get manufactured on a consistent basis, and it’s 

important to understand the differences between each so you can decide the right circuit board 

for your requirements. The three main types of circuit boards in current manufacture are: 

  

 Single-Sided Circuit Boards: These boards when made with a FR4 base have rigid 

laminate of woven glass epoxy material, which is then covered on one side with a copper 

coating that is applied in varying thicknesses depending on the application. 

  

 Double-Sided Circuit Boards: Double-sided boards have the same woven glass epoxy 

base as single-sided boards however, in the case of a double-sided board, there is copper 

coating on both sides of the board, also to varying thicknesses depending on the 

application 

  

 Multi-Layer Boards: These use the same base material as single and double-sided 

boards, but are made with copper foil instead of copper coating ,the copper foil is used to 

make “layers,” alternating between base material and copper foil until the number of 

desired layers is reached. 

 

Checking the circuit on breadboard 

For a allotted project we have searched a circuit diagram from reference books and Internet and 

brought components from market and in practical session we have constructed these circuits on 

breadboard and checked that whether for given components and connections circuits work or 

not.Once circuits found working we proceeded for PCB layouts. 

Breadboard Connections: 

A breadboard is a solderless device for temporary prototype with electronics and test circuit 

designs. Most electronic components in electronic circuits can be interconnected by inserting 
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their leads or terminals into the holes and then making connections through wires where 

appropriate. The breadboard has strips of metal underneath the board and connect the holes on 

the top of the board. The metal strips are laid out as shown below. Note that the top and bottom 

rows of holes are connected horizontally and split in the middle while the remaining holes are 

connected vertically. 

 
 

                                            Figure: Breadboard Connections 

 

PCB Layout Process- 

 PCB making involves the following stages 

 Draw the circuit diagram as compact as possible on a paper. Mark the points (component 

pins) to be drilled. This diagram is used for Pattern drawing on the copper clad board. 

 Draw the same diagram in the tracing / butter paper using the OHP marker pen. Draw the 

diagram carefully without any overlapping or shorting of tracks or components. The 

neatness of the PCB lies in the Pattern drawing. After drawing, see the other side of the 

paper. There is a Mirror Sketch of the tracks. This is the actual pattern of the PCB. 

 Place the Pencil carbon on the copper side of the copper clad board. The ink side of the 

carbon paper should face the copper layer. 

 Place the tracing paper with diagram over the carbon paper. The diagram should be in the 

middle part of the copper clad board. Fold the sides of the tracing and carbon papers and 

stick it using cello tape. This prevents the movement while drawing. 

 Once again redraw the diagram using the OHP marker pen so that the carbon ink will 

create a mirror sketch on the copper clad board. 

 Remove the tracing paper and carbon paper. Using the OHP marker pen, redraw the 

carbon pattern of the mirror sketch on the copper laminate. So that the tracks will be 

created using the permanent marker ink. Keep it for 10 minutes to dry the ink. 

 Mark points to be drilled. 
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PCB Etching Process 

Etching is a "subtractive" method used for the production of printed circuit boards: acid is used 

to remove unwanted copper from a prefabricated laminate. This is done by applying a temporary 

mask that protects parts of the laminate from the acid and leaves the desired copper layer 

untouched.All PCB’s are made by bonding a layer of copper over the entire substrate, sometimes 

on both sides. Etching process has to be done to remove unnecessary copper after applying a 

temporary mask, leaving only the desired copper traces. 

Though there are many methods available for etching, the most common method used  is etching 

using ferric chloride hydrochloric acid. Both are abundant and cheap. Dip the PCB inside the 

solution and keep it moving inside. Take it out at times and stop the process as soon as the 

copper layer has gone. After etching, rub the PCB with a little acetone to remove the black 

colour, thus giving the PCB a shining attractive look. The PCB layout is now complete. 

 

Continuity Test is a method to check current flow across any metallic path. Through this test, 

any unwanted circuit breaks or shorted connections can be put to verification. Continuity can be 

tested between any two circuit connections. 

Step 1: Take the circuit board of which you want to test the continuity. 

Step 2: Map the traced tracks and corresponding electronic components to be soldered on them. 

Step 3: Turn the knob on the multimeter towards the continuity section. 

Step 4:Select the metallic path of which you want to check the continuity and place one testing 

lead at the starting terminal and another at the other. 

Step 5: After placing the leads on their position the multimeter will produce a continuous beep 

sound indicating that track is continuous and there is no breakage in the track. 

 

Conclusion: 
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                                               Experiment No. 5 

 

Aim: Mini Project Electronic PCB Design-Part II- PCB Drilling & Soldering  

 

Equipments: Drilling Machine,Soldering gun,Metal 

 

PCB Drilling 

To make holes on your PCB you need a drill, a good vertical drill stands and drill bits. 

To drill fiberglass (FR4) board you must use tungsten carbide drill bits because fiberglass eats 

normal high-speed steel (HSS) bits very rapidly. Although HSS drills are good for odd larger 

sizes (>2mm) that you only use occasionally where the expense of a carbide isn’t justified. 

Carbide drill bits are expensive. To avoid drill bits break you must use a good vertical drill 

stand. Small drill bits that are made out of tungsten carbide is used for the drilling. For high 

volume production automated drilling machines are used. Typical hole sizes : ICs, resistors etc. 

0.8mm. Larger diodes, pin headers etc: 1.0mm, terminal blocks, trimmers etc. 1.2 to 1.5mm. 

Avoid hole sizes less than 0.8mm unless you really need them. Always keep at least 2 spare 

0.8mm drill bits, as they always break just when you need a PCB really urgently. 1.0 and larger 

are more resilient 

 

Soldering : Soldering  is a process in which two or more items (usually metal) are joined 

together by melting and putting a filler metal (solder) into the joint, the filler metal having a 

lower melting point than the adjoining metal. 

Tips for good Soldering: 

1. All parts must be clean and free from dirt and grease. 

2. Try to secure the work firmly. 

3. “Tin” the iron tip with a small amount of solder. Do this immediately, with new tips 

being used for the first time. 

4. Clean the tip of the hot soldering iron on a damp sponge (many people then add a tiny 

amount of fresh solder to the cleansed tip). 

5. Heat all parts of the joint with the iron for under a second or so. 

6. Continue heating, then apply sufficient solder only, to form an adequate joint. 

7. Remove and return the iron safely to its stand. 

8. It only takes two or three seconds at most, to solder the average PCB joint. 

9. Do not move parts until the solder has cooled. 

Testing: Unassembled circuit boards are subjected to a bare board test where each circuit 

connection is verified as correct on the finished circuit board. In high volume circuit board 

production, a bed of nails tester or fixture is used to make contact with the copper lands or holes 

on one or both sides of the board to facilitate testing. Computers are used to control the electrical 
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testing unit to send a small current through each contact point on the bed of nails and verify that 

such current can be detected on the appropriate contact points. 

For small to medium volume production runs, a flying probe tester is used to check electrical 

contacts. These flying probes employ moving heads to make contact with the copper lands and 

holes to validate the electrical connectivity of the board being tested. 

Conclusion: 
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                                       Experiment No. 6 

 

Aim: To study the overview of Arduino 
 

Arduino is a prototype platform (open-source) based on an easy-to-use hardware and software. It 

consists of a circuit board, which can be programed (referred to as a microcontroller) and a 

ready-made software called Arduino IDE (Integrated Development Environment), which is used 

to write and upload the computer code to the physical board. 

The key features are − 

 Arduino boards are able to read analog or digital input signals from different sensors and 

turn it into an output such as activating a motor, turning LED on/off, connect to the cloud 

and many other actions. 

 You can control your board functions by sending a set of instructions to the 

microcontroller on the board via Arduino IDE (referred to as uploading software). 

 Unlike most previous programmable circuit boards, Arduino does not need an extra piece 

of hardware (called a programmer) in order to load a new code onto the board. You can 

simply use a USB cable. 

 Additionally, the Arduino IDE uses a simplified version of C++, making it easier to learn 

to program. 

 Finally, Arduino provides a standard form factor that breaks the functions of the micro-

controller into a more accessible package. 

Board Types 

Various kinds of Arduino boards are available depending on different microcontrollers used. 

However, all Arduino boards have one thing in common: they are programed through the 

Arduino IDE. 

The differences are based on the number of inputs and outputs (the number of sensors, LEDs, 

and buttons you can use on a single board), speed, operating voltage, form factor etc. Some 

boards are designed to be embedded and have no programming interface (hardware), which you 

would need to buy separately. Some can run directly from a 3.7V battery, others need at least 

5V. 

Board 

Name 

Operating 

Volt 

Clock 

Speed 

Digital 

i/o 

Analog 

Inputs 

PWM UART Programming 

Interface 

Arduino 

Uno R3 
5V 16MHz 14 6 6 1 

USB via 

ATMega16U2 
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LilyPad 

Arduino 

simple 

board 

3.3V 8MHz 9 4 5 0 

FTDI-

Compatible 

Header 

Arduino 

Mega 2560  
5V 16MHz 54 16 14 4 

USB via 

ATMega16U2B 

 

 

 

 
 

                                                        Figure 1 : Arduino Uno Schematic 

 

Pin No         Pin Name Description 

1 
Power USB 

 

Arduino board can be powered by using the USB cable from 

your computer. All you need to do is connect the USB cable to 

the USB connection  

2 Power (Barrel Jack) 
Arduino boards can be powered directly from the AC mains 

power supply by connecting it to the Barrel Jack 
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3 Voltage Regulator 

The function of the voltage regulator is to control the voltage 

given to the Arduino board and stabilize the DC voltages used 

by the processor and other elements 

4 Crystal Oscillator 

The crystal oscillator helps Arduino in dealing with time issues. 

How does Arduino calculate time? The answer is, by using the 

crystal oscillator. The number printed on top of the Arduino 

crystal is 16.000H9H. It tells us that the frequency is 

16,000,000 Hertz or 16 MHz. 

5,17 Arduino Reset 

You can reset your Arduino board, i.e., start your program from 

the beginning. You can reset the UNO board in two ways. First, 

by using the reset button (17) on the board. Second, you can 

connect an external reset button to the Arduino pin labelled 

RESET  

6,7,8,9 
Pins (3.3, 5, 

GND, Vin) 

 3.3V (6) − Supply 3.3 output volt 

 5V (7) − Supply 5 output volt 

 Most of the components used with Arduino board 

works fine with 3.3 volt and 5 volt. 

 GND (8)(Ground) − There are several GND pins on the 

Arduino, any of which can be used to ground your 

circuit. 

 Vin (9) − This pin also can be used to power the 

Arduino board from an external power source, like AC 

mains power supply. 

10 Analog pins 

The Arduino UNO board has five analog input pins A0 through 

A5. These pins can read the signal from an analog sensor like 

the humidity sensor or temperature sensor and convert it into a 

digital value that can be read by the microprocessor. 

11 
Main 

microcontroller 

Each Arduino board has its own microcontroller. You can 

assume it as the brain of your board. The main IC (integrated 

circuit) on the Arduino is slightly different from board to board. 

The microcontrollers are usually of the ATMEL Company. 

You must know what IC your board has before loading up a 

new program from the Arduino IDE. This information is 

available on the top of the IC. For more details about the IC 

construction and functions, you can refer to the data sheet. 

12 ICSP pin 

Mostly, ICSP is an AVR, a tiny programming header for the 

Arduino consisting of MOSI, MISO, SCK, RESET, VCC, and 

GND. It is often referred to as an SPI (Serial Peripheral 

Interface), which could be considered as an "expansion" of the 
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output. Actually, you are slaving the output device to the 

master of the SPI bus 

13 
Power LED 

indicator 

This LED should light up when you plug your Arduino into a 

power source to indicate that your board is powered up 

correctly. If this light does not turn on, then there is something 

wrong with the connection 

14 TX and RX LEDs 

On your board, you will find two labels: TX (transmit) and RX 

(receive). They appear in two places on the Arduino UNO 

board. First, at the digital pins 0 and 1, to indicate the pins 

responsible for serial communication. Second, the TX and RX 

led (13). The TX led flashes with different speed while sending 

the serial data. The speed of flashing depends on the baud rate 

used by the board. RX flashes during the receiving process. 

15 Digital I/O 

The Arduino UNO board has 14 digital I/O pins (15) (of which 

6 provide PWM (Pulse Width Modulation) output. These pins 

can be configured to work as input digital pins to read logic 

values (0 or 1) or as digital output pins to drive different 

modules like LEDs, relays, etc.  

16 AREF 

AREF stands for Analog Reference. It is sometimes, used to set an 

external reference voltage (between 0 and 5 Volts) as the upper 

limit for the analog input pins. 

 

I/O Functions 

The pins on the Arduino board can be configured as either inputs or outputs. We will explain the 

functioning of the pins in those modes. It is important to note that a majority of Arduino analog 

pins, may be configured, and used, in exactly the same manner as digital pins. 

A. Pins Configured as INPUT 

Arduino pins are by default configured as inputs, so they do not need to be explicitly declared 

as inputs with pinMode() when you are using them as inputs. Pins configured this way are said 

to be in a high-impedance state. Input pins make extremely small demands on the circuit that 

they are sampling, equivalent to a series resistor of 100 megaohm in front of the pin. 

This means that it takes very little current to switch the input pin from one state to another. This 

makes the pins useful for such tasks as implementing a capacitive touch sensor or reading an 

LED as a photodiode. 

Syntax: 
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pinMode(3,INPUT) ; // set pin 3 to input 

 

B. Pins Configured as OUTPUT 

Pins configured as OUTPUT with pinMode() are said to be in a low-impedance state. This 

means that they can provide a substantial amount of current to other circuits. Atmega pins can 

source (provide positive current) or sink (provide negative current) up to 40 mA (milliamps) of 

current to other devices/circuits. This is enough current to brightly light up an LED (do not 

forget the series resistor), or run many sensors but not enough current to run relays, solenoids, 

or motors. 

Attempting to run high current devices from the output pins, can damage or destroy the output 

transistors in the pin, or damage the entire Atmega chip. Often, this results in a "dead" pin in the 

microcontroller but the remaining chips still function adequately. For this reason, it is a good 

idea to connect the OUTPUT pins to other devices through 470Ω or 1k resistors, unless 

maximum current drawn from the pins is required for a particular application. 

Syntax: 

pinMode(5,OUTPUT) ; // set pin 5 to output 

 

C. digitalWrite( ) Function 

The digitalWrite() function is used to write a HIGH or a LOW value to a digital pin. If the pin 

has been configured as an OUTPUT with pinMode(), its voltage will be set to the corresponding 

value: 5V (or 3.3V on 3.3V boards) for HIGH, 0V (ground) for LOW. If the pin is configured 

as an INPUT, digitalWrite() will enable (HIGH) or disable (LOW) the internal pullup on the 

input pin. It is recommended to set the pinMode() to INPUT_PULLUP to enable the internal 

pull-up resistor. 

If you do not set the pinMode() to OUTPUT, and connect an LED to a pin, when calling 

digitalWrite(HIGH), the LED may appear dim. 

digitalWrite() Function Syntax: 

Void loop() { 

   digitalWrite (pin ,value); 

} 

 pin − the number of the pin whose mode you wish to set 

https://www.arduino.cc/en/Reference/PinMode
https://www.arduino.cc/en/Reference/PinMode
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 value − HIGH, or LOW. 

D. analogRead( ) function 

Arduino is able to detect whether there is a voltage applied to one of its pins and report it 

through the digitalRead() function. There is a difference between an on/off sensor (which 

detects the presence of an object) and an analog sensor, whose value continuously changes. In 

order to read this type of sensor, we need a different type of pin. 

In the lower-right part of the Arduino board, you will see six pins marked “Analog In”. These 

special pins not only tell whether there is a voltage applied to them, but also its value. By using 

the analogRead() function, we can read the voltage applied to one of the pins. 

This function returns a number between 0 and 1023, which represents voltages between 0 and 5 

volts. For example, if there is a voltage of 2.5 V applied to pin number 0, analogRead(0) returns 

512. 

analogRead() function Syntax: 

analogRead(pin); 

 pin − the number of the analog input pin to read from (0 to 5 on most boards, 0 

to 7 on the Mini and Nano, 0 to 15 on the Mega) 

 

Conclusion: 
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                                            Experiment No. 7 

 

Aim: Study the Installation of Arduino UNO & Arduino IDE 

 

Equipments: USB Cable,Arduino UNO board,Arduino IDE Software 

 

Theory: After learning about the main parts of the Arduino UNO board, we are ready to learn 

how to set up the Arduino IDE. Once we learn this, we will be ready to upload our program on 

the Arduino board. 

In this section, we will learn in easy steps, how to set up the Arduino IDE on our computer and 

prepare the board to receive the program via USB cable. 

Step 1 − First you must have your Arduino board (you can choose your favorite board) and a 

USB cable. In case you use Arduino Nano, Arduino UNO,Arduino Mega 2560, or Diecimila, 

you will need a standard USB cable (A plug to B plug), the kind you would connect to a USB 

printer as shown in the following image. 

                                           

                                                   Figure: USB Cable 

 

Step 2 − Download Arduino IDE Software. 

 

You can get different versions of Arduino IDE from the Download page on the Arduino Official 

website. You must select your software, which is compatible with your operating system 

(Windows, IOS, or Linux). After your file download is complete, unzip the file. 

Download Link: https://www.arduino.cc/en/Main/Software 

 

Step 3 − Power up your board. 

 

The Arduino Uno, Mega, Duemilanove and Arduino Nano automatically draw power from 

either, the USB connection to the computer or an external power supply. If you are using an 

Arduino Diecimila, you have to make sure that the board is configured to draw power from the 
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USB connection. The power source is selected with a jumper, a small piece of plastic that fits 

onto two of the three pins between the USB and power jacks. Check that it is on the two pins 

closest to the USB port. 

Connect the Arduino board to your computer using the USB cable. The green power LED 

(labeled PWR) should glow. 

 

 

Step 4 − Launch Arduino IDE. 

 

After your Arduino IDE software is downloaded, you need to unzip the folder. Inside the folder, 

you can find the application icon with an infinity label (application.exe). Double-click the icon to 

start the IDE. 

 

Step 5 − Open your first project. 

 

Once the software starts, you have two options − 

 

Create a new project. 

Open an existing project example. 

To create a new project, select File → New. 

 
 

To open an existing project example, select File → Example → Basics → Blink. 
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Step 6 − Select your Arduino board. 

 

To avoid any error while uploading your program to the board, you must select the correct 

Arduino board name, which matches with the board connected to your computer. 

 

Go to Tools → Board and select your board. 
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Step 7 − Select your serial port. 

 

Select the serial device of the Arduino board. Go to Tools → Serial Port menu. This is likely to 

be COM3 or higher (COM1 and COM2 are usually reserved for hardware serial ports). To find 

out, you can disconnect your Arduino board and re-open the menu, the entry that disappears 

should be of the Arduino board. Reconnect the board and select that serial port. 

 

To check the com port to which Arduino is connected Go to My Computer Right Click  

Manage  Device Manager  and check the com port assigned for Arduino. 

 
 

Step 8 − Upload the program to your board. 

 

Before explaining how we can upload our program to the board, we must demonstrate the 

function of each symbol appearing in the Arduino IDE toolbar. 
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A − Used to check if there is any compilation error. 

 

B − Used to upload a program to the Arduino board. 

 

C − Shortcut used to create a new sketch. 

 

D − Used to directly open one of the example sketch. 

 

E − Used to save your sketch. 

 

F − Serial monitor used to receive serial data from the board and send the serial data to the board. 

 

Now, simply click the "Upload" button in the environment. Wait a few seconds; you will see the 

RX and TX LEDs on the board, flashing. If the upload is successful, the message "Done 

uploading" will appear in the status bar. 

 

Note − If you have an Arduino Mini, NG, or other board, you need to press the reset button 

physically on the board, immediately before clicking the upload button on the Arduino Software. 

 

Conclusion: 
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                                           Experiment No. 8 

 

Aim: Interfacing LED & Ultrasonic Sensor with Arduino 

Components :Breadboard,Arduino Uno R3,LED,330Ω Resistor, ULTRASONIC Sensor (HC-

SR04)  

 

LEDs are small, powerful lights that are used in many different applications. To start, we will 

work on blinking an LED, the Hello World of microcontrollers. It is as simple as turning a light 

on and off. Establishing this important baseline will give you a solid foundation as we work 

towards experiments that are more complex. 

 

Procedure: 

 
 

Arduino Code: 

 

/* 

   Blink 

   Turns on an LED on for one second, then off for one second, repeatedly. 

*/ 

 

// the setup function runs once when you press reset or power the board 

 

void setup() {  // initialize digital pin 13 as an output. 

   pinMode(2, OUTPUT); 

} 

 

// the loop function runs over and over again forever 
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void loop() { 

   digitalWrite(2, HIGH); // turn the LED on (HIGH is the voltage level) 

   delay(1000); // wait for a second 

   digitalWrite(2, LOW); // turn the LED off by making the voltage LOW 

   delay(1000); // wait for a second 

} 

 

Interfacing Ultrasonic Sensor: 

 

The HC-SR04 ultrasonic sensor uses SONAR to determine the distance of an object just like the 

bats do. It offers excellent non-contact range detection with high accuracy and stable readings in 

an easy-to-use package from 2 cm to 400 cm or 1” to 13 feet. 

The operation is not affected by sunlight or black material, although acoustically, soft materials 

like cloth can be difficult to detect. It comes complete with ultrasonic transmitter and receiver 

module. 

  

                                          

                Figure: HC-SR04 Module 

The Ultrasonic sensor has four terminals - +5V, Trigger, Echo, and GND connected as follows − 

 

Connect the +5V pin to +5v on your Arduino board. 

Connect Trigger to digital pin 7 on your Arduino board. 

Connect Echo to digital pin 6 on your Arduino board. 

Connect GND with GND on Arduino. 
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Technical Specifications 

Power Supply − +5V DC 

Quiescent Current − <2mA 

Working Current − 15mA 

Effectual Angle − <15° 

Ranging Distance − 2cm – 400 cm/1″ – 13ft 

Resolution − 0.3 cm 

Measuring Angle − 30 degree 

 

Program Code : 

const int pingPin = 7; // Trigger Pin of Ultrasonic Sensor 

const int echoPin = 6; // Echo Pin of Ultrasonic Sensor 

 

void setup() { 

   Serial.begin(9600); // Starting Serial Terminal 

} 

 

void loop() { 



38 
 

   long duration, inches, cm; 

   pinMode(pingPin, OUTPUT); 

   digitalWrite(pingPin, LOW); 

   delayMicroseconds(2); 

   digitalWrite(pingPin, HIGH); 

   delayMicroseconds(10); 

   digitalWrite(pingPin, LOW); 

   pinMode(echoPin, INPUT); 

   duration = pulseIn(echoPin, HIGH); 

   inches = microsecondsToInches(duration); 

   cm = microsecondsToCentimeters(duration); 

   Serial.print(inches); 

   Serial.print("in, "); 

   Serial.print(cm); 

   Serial.print("cm"); 

   Serial.println(); 

   delay(100); 

} 

 

long microsecondsToInches(long microseconds) { 

   return microseconds / 74 / 2; 

} 

long microsecondsToCentimeters(long microseconds) { 

   return microseconds / 29 / 2; 

} 

 

Conclusion: 
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                                                   Experiment No. 9 

 

Aim: The report regarding the organization/ Industry 

 

Aim: The report regarding the organization/ Industry 

  

Student should write report of at least 4-5 pages about the companies situated in Aurangabad .It 

should consist of following points:  

 

1. Industry Name  

2. Brief Information about the company like Establishment, Owner and Journey of Company 

2. Various Products 

3. Clients 

4. Locations/Branches 

5. Various Job opportunities at the company 

6. Achievements/Milestones of the company 

 

Conclusion: 
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                                                    Experiment No. 10 

 

Aim: Mini project report. 

 

Students should write report of at least 18-20 pages about project they have implemented in 

Electronic Workshop Lab. 

 

It should consist of following points:  

1. Title   

2. Introduction 

3. Circuit diagram  

4. PCB lay out  

5 Working / Description  

6. Components list and cost  

 

 Conclusion: 
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2. Quiz on the subject:  

1) What Is Need For A Pcb? 

2)  What are the types of Printed circuit board ? 

3) Enlist different software used for PCB design ? 

4) What are SMD components? 

5) What are the different wattage ratings available for soldering gun? 

6) What is the type of metal used for soldering and temperature required? 

7) What are different sizes of drilling bit used in lab? 

8) What are the alternatives available for FeCl3 solution? 

9) Which type of material used as PCB? 

11)Write the specifications of IN4007 diode. 

12) What are the different IC packages available? 

13) How IC 555 works in monostable mode? 

14) What are the specifications of speaker? 

15) What are the specifications and types of Buzzer? 

16) What are the different ratings of Resistor? 

17) What is the make of soldering machine & Drilling machine that used in lab? 

18) Describe working of IR sensor. 

19) Give names of different controllers used in Electronics. 

20) What do you mean by compiler? 

 21) What is the microcontroller used in Arduino UNO? 

22)  An audio amplifier is an example of ……………… 

23) The most popular types of ICs are ………….. 

24) What are the Specifications of LM35 temperature sensor IC ? 

25) Explain basic Principle of PWM? 
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3. Conduction of Viva-Voce Examinations:  

Teacher should conduct oral exams of the students with full preparation. Normally, the objective 

questions with guess are to be avoided. To make it meaningful, the questions should be such that 

depth of the students in the subject is tested. Oral examinations are to be conducted in co-cordial 

environment amongst the teachers taking the examination. Teachers taking such examinations 

should not have ill thoughts about each other and courtesies should be offered to each other in 

case of difference of opinion, which should be critically suppressed in front of the students.  

4. Evaluation and marking system:  

Basic honesty in the evaluation and marking system is absolutely essential and in the process, 

impartial nature of the evaluator is required in the examination system. It is a wrong approach or 

concept to award the students by way of easy marking to get cheap popularity among the 

students, which they do not deserve. It is a primary responsibility of the teacher that right 

students who are really putting up lot of hard work with right kind of intelligence are correctly 

awarded.  

The marking patterns should be justifiable to the students without any ambiguity and teacher 

should see that students are faced with just circumstances. 
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